
    

 
 

 

 

  
 

 

 
 
 
 

  
 

 

USER’S  GUIDE  FOR ESTIMATING  
INDIRECT CARBON  DIOXIDE  
EQUIVALENT  EMISSIONS  FROM  
ELECTRICITY  CONSUMPTION 
USING  THE STATE  INVENTORY  
TOOL  

NOVEMBER 2019 

Prepared by: 
ICF 

Prepared  for:  
State  Energy  and  Environment  Program,   
U.S.  Environmental  Protection  Agency  

This section  of  the  User’s Guide  provides  instruction  on using  the  Indirect  CO2  from  
Electricity  Consumption  (Electricity  Consumption) module  of  the  State  Inventory  Tool  (SIT),  
and  describes  the  methodology  used  for estimating  greenhouse  gas  emissions from  
electricity  consumption  at  the  state  level.   
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1.1  GETTING  STARTED  

The  Indirect  Carbon  Dioxide  Equivalent (CO2  Eq.) from  Electricity  Consumption  (Electricity  
Consumption) module  was  developed  using  Microsoft®  Excel  2000.   While  the  module  will  
operate  with  older  versions  of  Excel,  it functions  best with  Excel  2000  or  later.   If  you  are  
using Excel  2007  or later,  instructions  for o pening  the  module  will  vary  as  outlined  in  the  
Excel  basics below.  Before  you  use  the  Electricity  Consumption  module,  make  sure  your 
computer  meets  the  system  requirements.   In  order to  install  and  run  the  Electricity  
Consumption  module,  you must  have:  

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation. To check this setting, launch Microsoft Excel before opening the 
Electricity Consumption module. Go to the Tools menu and select “Options...” Click on the 
“Calculations” tab and make sure that the radio button next to “Automatic” is selected, and 
then click on “OK” to close the window. The security settings (discussed next) can also be 
adjusted at this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu. 

Microsoft Excel Security 

Excel 2003 and Earlier: Since the SIT employs macros, you must have Excel security set 
to medium (recommended) or low (not recommended). To change this setting, launch 
Microsoft Excel before opening the Electricity Consumption module. Once in Excel, go to the 
Tools menu, click on the Macro sub-menu, and then select “Security” (see Figure 1). The 
Security pop-up box will appear. Click on the “Security Level” tab and select medium. 
When set to high, macros are automatically disabled; when set to medium, Excel will give 
you the choice to enable macros; when set to low, macros are always enabled. 

When  Excel  security  is  set  to  medium,  users  are asked  upon  opening  the  module  whether t o  
enable  macros.   Macros  must  be  enabled  in  order for  the  Electricity  Consumption  module  to  
work.   Once  they  are  enabled,  the  module  will  open  to the  control  worksheet.   A  message  
box  will  appear  welcoming  the  user  to  the  module.   Clicking  on  the  “x”  in  the  upper-right-
hand  corner  of  the  message  box  will  close  it.  

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the Electricity Consumption module 
is initially opened. The Security Warning lets the user know that some active content from 
the spreadsheet has been disabled, meaning that Excel has prevented the macros in the 
spreadsheet from functioning. Since SIT needs macros in order to function properly, the 
user must click the “Options” button in the security message and then select, “Enable this 
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content” in the pop-up box. Enabling the macro content for the SIT in this way only enables 
macros temporarily in Excel but does not change the macro security settings. Once macros 
are enabled, a message box will appear welcoming the user to module. Click on the “x” in 
the upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros. To change the setting, first exit out 
of the Electricity Consumption module and re-launch Microsoft Excel before opening the 
Electricity Consumption module. Next, click on the Microsoft Excel icon in the top left of the 
screen. Scroll to the bottom of the menu and select the “Excel Options” button to the right 
of the main menu. When the Excel Options box appears, select “Trust Center” in left hand 
menu of the box. Next, click the gray “Trust Center Settings” button. When the Trust 
Center options box appears, click “Macro Settings” in the left hand menu and select “Disable 
all macros with notification.” Once the security level has been adjusted, open the 
Stationary Combustion module and enable macros in the manner described in the preceding 
paragraph. 

Viewing and Printing Data and Results 

The Electricity Consumption module contains some features to allow users to adjust the 
screen view and the appearance of the worksheets when they are printed. Once a module 
has been opened, you can adjust the zoom by going to the Module Options Menu, and either 
typing in a zoom percentage or selecting one from the drop down menu. In addition, data 
may not all appear on a single screen within each worksheet; if not, you may need to scroll 
up or down to view additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the Electricity Consumption module are printed. To do so, go to the File menu, and then 
select “Print Preview.” Click on “Page Break Preview” and drag the blue lines to the desired 
positions (see Figure 2). To print this view, go to the File menu, and click “Print.” To return 
to the normal view, go to the File menu, click “Print Preview,” and then click “Normal View.” 

Figure 1. Changing Security Settings Figure  2.  Adjusting  Print  Margins  
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1.2   MODULE  OVERVIEW  

This User’s Guide accompanies and explains the Electricity Consumption module of the SIT. 
Many of the SIT modules were developed in conjunction with EPA’s Emissions Inventory 
Improvement Program (EIIP). Prior to the development of the SIT, EPA developed the 
States Workbook for estimating greenhouse gas emissions. In 1998, EPA revisited the 
States Workbook and expanded it to follow the format of EIIP guidance documents for 
criteria air pollutants. The result was a comprehensive, stepwise approach to estimating 
greenhouse gas emissions at the state level. This detailed methodology was appreciated by 
states with the capacity to devote considerable time and resources to the development of 
emission inventories. For other states, the EIIP guidance was overwhelming and impractical 
for them to follow from scratch. EPA recognized the resource constraints facing the states 
and developed the SIT. Ten of the SIT modules corresponded to the EIIP chapters and 
attempted to automate the steps states would need to take in developing their own 
emission estimates in a manner that was consistent with prevailing national and state 
guidelines. 

The  Electricity  Consumption  module  is  the  eleventh,  and  newest,  module  developed  as  part 
of  the  SIT  suite  of  modules.  EPA  recognized  a  need  for a  module  and  guidance  to  estimate  
indirect  greenhouse  gas  emissions  from  electricity  consumption  at  the  state  level.  In using  
this  module,  an  important distinction  between  direct and  indirect  emissions  must  be  made.  
Direct  emissions  (estimated  in  the  CO2  from Fossil Fuel Combustion  module)  result  from  the  
combustion  of  fossil  fuels at  the  electricity  generating  station, whereas indirect  emissions 
occur  at the  point of  use  (e.g.,  residential space  heating  electricity  consumption).   State  
inventories  can  include  direct  emissions  associated  with  electricity  generation  occurring  in  
the  state  and/or  indirect  emissions associated  with  electricity  consumed  within  the  
boundaries  of  the  state.   Because  electricity  consumption  within  a  state  does  not correspond  
to electricity  generated  in  that  state,  emissions  from  consumption  (indirect  emissions)  are  
not  likely  to be  the  same  as  emissions  from  generation  (direct  emissions).   States  are  
encouraged  to include  direct  emissions  in  their  inventory e stimates,  and  estimate  and  
include  indirect  emissions  as  an  informational line  item.  Including  both  direct  and  indirect  
estimates  may  lead  to  double  counting.   If  the  goal  of  the  inventory  is  to  encourage  action  
and  reduce  emissions  within  the  state,  it  would  be  beneficial to  include  emissions  at  the  
point  of  consumption  (i.e.,  indirect  emissions  from  electricity  consumption).   

Since  most  state  inventories  developed  today  rely  heavily  on  the  tools,  User’s  Guides  have  
been  developed  for  each  of  the  SIT  modules.   These User’s  Guides  contain the  most  up-to-
date  methodologies  that are,  for  the m ost part,  consistent with  the  U.S.  EPA’s  Inventory  of  
U.S.  Greenhouse  Gas  Emissions  and Sinks.   In  addition,  the  emission  factors  developed  for 
the  Electricity  Consumption  module  are  consistent  with  emission  factors from  Emissions &  
Generation  Resource  Integrated  Database  (eGRID)  (U.S.  EPA 2007,  U.S.  EPA 2010,  U.S.  
EPA 2012,  U.S.  EPA 2014,  U.S.  EPA  2015,  U.S.  EPA 2017,  and U.S.  EPA  2018).  

The  Electricity  Consumption  module  calculates  carbon  dioxide  equivalent  (CO2  Eq.)  
emissions from  the  electricity  consumption  by  the  end-use  equipment  types  shown  in  Table  
1,  by  end-use  sector.   While  the  module  provides  default  data  for  electricity  consumption  by  
end-use  types  (depending on  availability),  users  are  encouraged  to  use  state-specific data, 
where  available.   If  using  outside  data  sources,  or f or  a  more thorough understanding  of  the  
tool,  please  refer to the  following  discussion  for  data  requirements  and  methodology.  
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1.2.1  Data Requirements  

To  calculate  CO2  Eq.  emissions from  electricity  consumption,  the  following data  are  
required:  

• Electricity consumption by sector; 

• Percent electricity consumption by end-use equipment; 

• Electricity emission factors; and 

• Transmission loss factors. 

Electricity  consumption  statistics should  be  collected  
on  a  kilowatt-hour1  (kWh) basis.  Statistics  providing  
energy  consumption data  in other  units,  British  
Thermal  Units  (Btu), may  be  used,  but  require  
conversion  to  kWh.  One  kWh  is  equivalent t o  3,412  
Btu.  Please  note  that even  data  given  in  Btu  may  be  
preceded  by  a  prefix  indicating  order  of  magnitude  
(i.e.  thousand,  million,  billion).   For  a  better  
understanding  of  the  quantity  prefixes  used with  Btu,  
refer to  Box  1.   

Box 1: Energy Units 
A  British thermal uni t (Btu) is  the  quantity  
of  heat required  to  raise  the  temperature  of  
one  pound  of  water  one  degree  Fahrenheit 
at  or near 39.2o  Fahrenheit.  

Btu  British thermal uni t  1  Btu  
MBtu  Thousand  Btu  1x103  Btu  
MMBtu  Million Btu  1x106  Btu  
BBtu  Billion Btu  1x109  Btu  
TBtu  Trillion Btu  1x1012  Btu  
QBtu  Quadrillion Btu  1x1015  Btu  

The  Electricity  Consumption  module  calculates 
carbon  dioxide  equivalent  (CO2  Eq.)  emissions  from  the  electricity  consumption  by  the  end-
use  equipment types,  by  end-use  sector  shown  in Table  1.   The  following  sections  provide  a  
discussion  of the  available  data  for  each  sector.  

Table 1. End-Use Equipment by Sector 
Residential1 Commercial2 Industrial3 Transportation4 

Space Heating 
Air-conditioning 
Water Heating 
Refrigeration 
Other 

Appliances 
and Lighting 

Space Heating 
Cooling 
Ventilation 
Water Heating 
Lighting 
Cooking 
Refrigeration 
Office 

Equipment 
Computers 
Other 

Indirect Uses- Boiler Fuel 
Conventional Boiler Use 
CHP and/or Cogeneration 

Process 
Direct Uses- Total Process 
Process Heating 
Process Cooling and 

Refrigeration 
Machine Drive 
Electro-Chemical Processes 
Other Process Use 
Direct Uses- Total 

Nonprocess 
Facility HVAC 
Facility Lighting 
Other Facility Support 
Onsite Transportation 
Other Nonprocess Use 

Automated 
Guideway 

Bus (charged 
batteries) 

Cable Car 
Commuter Rail 
Heavy Rail 
Inclined Plane 
Light Rail 
Trolleybus 
Other 

Source:  1EIA  2018,  2EIA  2016,  3EIA 2017,  and  4FTA  2018  

1  A measure of electricity defined as a unit of work or  energy, measured as 1  kilowatt (1,000 watts) of  
power expended for 1 hour. One kWh is equivalent to 3,412 Btu.  
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1.2.2  Tool Layout  

Since there are multiple steps to complete within the Electricity Consumption module, it is 
important to understand the module’s overall design. The layout of the Electricity 
Consumption module and the purpose of its worksheets are presented in Figure 3. 

Figure 3. Flow of Information in the Electricity Consumption Module* 

* These worksheets are the primary worksheets used in the Electricity Consumption module; subsequent 
worksheets are used to populate the default data and are provided for informational purposes only. 

1.3  METHODOLOGY  

This section  provides a  guide  to  using  the  
Electricity  Consumption  module  of  the  SIT  
to  estimate  indirect  CO2  Eq.  emissions 
from  sectors  and  end-use  equipment  that 
consume  electricity.   Within  the  Electricity  
Consumption  module,  these  sectors are  
residential,  commercial,  transportation,  
and  industrial.  Since  the  methodology  is  
similar  in  all  sectors,  a  general  methodology  is discussed  and  specific examples for  each  
sector  are  provided.  

Box  2: S tate  Energy  Data  Sources  
In-state  sources, such as  state  energy  commissions  or  public  
utility  commissions, should  be  consulted  first.  Otherwise,  
default data  provided  by  the  Electricity  Consumption  module  
may  be  used.   Electricity  consumption  statistics  should  be  
provided  on  a  kWh  basis.  

The  Electricity  Consumption  module  automatically  calculates  emissions  after  you  enter 
factors on  the  emission  factor  worksheet,  electricity  consumption  data,  and  the  percent 
consumption  by  end-use  sector  equipment.   The  tool  provides  default electricity  
consumption  data, which  comes from  the  EIA’s  State  Energy  Consumption,  Price,  and  
Expenditure  Estimates  (SEDS)  EIA  (2019).2   However,  other  more  state-specific data  may  
be  used  if  available  (see  Box  2  for  suggestions  on  where  to  find  data).    

This User’s Guide provides an overview of the estimation methodology used in the Electricity 
Consumption module by walking through the following steps: (1) select a state; (2) 
complete the emission factor worksheet; (3) complete the residential sector worksheet; (4) 
complete the commercial sector worksheet; (5) complete the transportation sector 

2  These data are available at  https://www.eia.gov/state/seds/.     
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worksheet (6) complete the industrial sector worksheet; (7) review summary information; 
and (8) export data. 

The  general  equation  use  to  calculate  indirect  CO2  Eq.  emissions  from  electricity  
consumption  is shown in Equation  1.    

Equation  1.   General  Emission  Equation  

 Emissions (MMTCO2E) =  
{(Total State  Consumption (kWh)  ×  End-Use Equipment Consumption (%)) ÷  (1- 

Transmission Loss  Factor (%))}  × Emission Factor (lbs CO2E/kWh)  ×  0.0005 short ton/lbs  
× 0.90718 (Ratio of Short Tons to Metric Tons) ÷ 1,000,000  

Step (1) Select a State 

To begin, select the state you are interested in evaluating. By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool. 

Step (2) Complete the Factors Worksheet 

Step  2  requires  users  to  select  appropriate  factors  for several  key  variables  necessary  for  
estimating  indirect  CO2  emissions from  electricity  consumption.   On  the  Factors  worksheet,  
default  electricity  emission  factors and  transmission  loss factors are  provided  and  will  be  
used  to  estimate  emissions  throughout the  tool.  To  select  all  of  the  default data,  select  the  
“Check  All  Boxes” button  on  the  Factors  worksheet  or check  the  default  box  directly  above  
the  yellow  input  cells  for each  year in  the  time  series.   Note  that  users  may  select  a  default  
factor and  later override  the  factor if  better data  becomes  available.  An  example  of  the  
Factors  worksheet  is  provided  in  Figure  4  below.     

Default  emission  factors  for  electricity  consumption  (lbs CO2E/kWh) are  provided  in the  
Factors worksheet.  Values  are  derived  from  Year 2005,  2007,  2009,  2010,  2012,  2014,  and  
2016  Emissions  &  Generation  Resource  Integrated  Database  (eGRID)  subregion  values,  
weighted  by  the  number  of  households  based  on  distribution  utilities  within  in  each  eGRID  
subregion  in each state  (U.S.  EPA 2007,  U.S.  EPA  2010,  U.S.  EPA 2012,  U.S.  EPA 2014,  U.S.  
EPA 2015,  U.S.  EPA 2017,  and U.S.  EPA  2018).  This  weighted emission  factor  is  intended  to  
better  reflect emissions  related  to  electricity  consumption  within  a  state,  and  take  into  
account the  flow  of  electricity  across  state  boundaries. Since  these  emission  factors do  not  
account  for  any  transmission  and  distribution losses  between the points  of  generation and  
the  points of consumption, a  transmission  loss factor  must  be  applied. The  transmission  loss 
factor takes  into account  electric  energy  lost  due  to  the  transmission  and  distribution  of  
electricity.  Additional  information  on  eGRID  emission  factors i s p rovided  in  Box  3.   
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Box  3:  eGRID  Emission  Factors  
The Emissions & Generation Resource Integrated Database (eGRID) is a comprehensive inventory of 
environmental attributes of electric power systems. The preeminent source of air emissions data for the 
electric power sector, eGRID is based on available plant-specific data for all U.S. electricity generating 
plants that provide power to the electric grid and report data to the U.S. government. eGRID integrates 
many different federal data sources on power plants and power companies, from three different federal 
agencies: EPA, the Energy Information Administration (EIA), and the Federal Energy Regulatory 
Commission (FERC). eGRID also provides aggregated data by state, U.S. total, company, and by three 
different sets of electric grid boundaries. 

Plant level emissions in eGRID are built by summing its component parts – which could simply be unit 
level boilers and/or turbines or a combination of boilers and prime movers representing an aggregation 
of like generating units. In general, eGRID plant level emissions reflect a combination of monitored and 
estimated data. Emissions and emission rates in eGRID represent emissions and rates at the point(s) of 
generation. They do account for losses within the generating plants (net generation). 

Note that default emission factors are estimated throughout alternate years in the time 
series. While these emission and transmission loss factors were developed for 2005, 2007, 
2009, 2010, 2012, 2014, and 2016, emission factor and household data were not available 
for the remaining years in the time series. To facilitate emission calculations for other years, 
the tool utilizes the 2005, 2007, 2009, 2010, 2012, 2014, and 2016 emission factors to 
linearly interpolate intermediate years and proxy the beginning and end of the time series. 
2005 emission factors are used from 1990 through 2005. Emission factors are linearly 
interpolated for 2006 (using 2005 and 2007 eGRID factors), 2008 (using 2007 and 2009 
eGRID factors), 2011 (using 2010 and 2012 eGRID factors), 2013 (using 2012 and 2014 
eGRID factors), and 2015 (using 2014 and 2016 eGRID factors). 2016 emissions factors are 
used to proxy 2017 through 2020. Emission factors within the module will be updated as 
soon as new data become available. 

Figure  4. Factors  Worksheet  for  the Electricity Consumption  Module  

Select All Defaults 

Individual Default 
Data Check Boxes 
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Step (3) through Step (6) Complete Individual Sector Worksheets 

The  worksheets  for each  sector have  the  same  basic set-up,  with  variations  in the c olor  of  
the  data  input cells,  and  the  end-use  equipment  for each  end-use  sector.   On  the  residential  
sector  worksheet,  presented  as  an  example  in  Figure  5,  the  orange  cells  indicate  where  the  
required  energy  activity  data  are  entered  either  manually  or  automatically  from d efault  
data.   This  activity  data  are  converted  into  CO2  emissions using  the  factors  entered  on  the  
Factors  worksheet  and  the  formula  presented  in  Equation  1.    

There are two types of activity data required to populate the orange cells in the residential 
sector worksheet. First, activity data used to populate the orange cells is annual electricity 
consumption by sector (e.g., residential, commercial, transportation, and industrial). 
Default annual electricity consumption is from EIA’s State Energy Data System (EIA 2019). 

The  second  piece  of  activity  data  required  to  estimate  emissions  is  the  percent  end-use  
equipment for each  sector across the  state. A  list  of  end-use equipment  that  consumes  
electricity  in  each  sector  is  provided  in  Table  1  and  is  included  in  the  Electricity  Consumption  
module.   End-use  consumption  data  used  in  the  module  is derived  from  a  variety  of  
publications,  discussed  further in  Box  4.  

The  Electricity  Consumption  module  calculates emissions for  each  sector  by  multiplying  total  
electricity  consumption  by  the  percent  consumption by  end-use  equipment  and  the  emission  
and  transmission  loss factor  to  obtain  the  total  carbon  emitted.   Then,  the  total  amount  of  
carbon  emitted  are  converted  into  MMTCO2E,  by  multiplying  by  the  ratio  of  metric  tons  per  
short  ton  (0.9072)  to  obtain  metric  tons  and  dividing  by  106  and multiplying by  44/12  to  
express emissions in  MMTCO2E  (Equation  1).  

Figure 5. Example of the Required Electricity Data in the Residential Worksheet 

Required Electricity Consumption Data 

End-Use Equipment Data 
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Box  4:  End-Use  Equipment  Data  Sources  
Residential 

Residential end-use equipment activity is from the Residential Energy Consumption Survey 
(RECS) (EIA 2018). The Residential Energy Consumption Survey (RECS) provides information on 
the use of energy in residential housing units in the United States. This information includes: the 
physical characteristics of the housing units; the appliances utilized including space heating and 
cooling equipment; demographic characteristics of the household; the types of fuels used; and 
other information that relates to energy use. The RECS also provides energy consumption and 
expenditures data for: natural gas, electricity, fuel oil, liquefied petroleum gas (LPG), and 
kerosene. The RECS is published in 4 year intervals. As a result, the Electricity Consumption 
Module uses 2001, 2005, 2009, and 2015 RECS data, and interpolates to estimate intervening 
years. Activity data beyond 2015 is proxied to the 2015 values. The Electricity Consumption 
Module utilizes regional-level data available from the RECS. 

RECS data are available online at: https://www.eia.gov/consumption/residential/. 

Commercial  

Commercial end-use equipment activity is from the Commercial Building Energy Consumption 
Survey (CBECS) (EIA 2016). The Commercial Buildings Energy Consumption Survey (CBECS) is a 
national sample survey that collects information on the stock of U.S. commercial buildings, their 
energy-related building characteristics, and their energy consumption and expenditures. 
Commercial buildings include all buildings in which at least half of the floorspace is used for a 
purpose that is not residential, industrial, or agricultural, so they include building types that might 
not traditionally be considered "commercial," such as schools, correctional institutions, and 
buildings used for religious worship. The CBECS has been published for 2003 and 2012. As a 
result, the Electricity Consumption Module uses 2003 and 2012 data and proxies other years in 
the time series to these estimates (1990 through 2002 are proxied to 2003 and 2012 through 
2020 are proxied to 2012). The Electricity Consumption Module utilizes regional-level data 
available from the CBECS. 

CBECS data are available online at: https://www.eia.gov/consumption/commercial/. 

Transportation  

Transportation end-use equipment activity is from the National Transit Database (NTD) (FTA 
2018). The NTD was established by Congress to be the Nation’s primary source for information 
and statistics on the transit systems of the United States. The data contained in the 2017 
National Transit Database (NTD) is one of three publications comprising the National Transit 
Database Program’s Annual Report. It provides detailed summaries of financial and operating 
data submitted to the Federal Transit Administration (FTA) by the nation's mass transit agencies 
for the report year ending on or between January 1 and December 31, 2017. The Electricity 
Consumption Module uses 2007 through 2017 data from the NTD, and proxies 1990 through 
2006 to 2007 and 2018 through 2020 to 2017. The Electricity Consumption Module utilizes state-
level data available from the NTD. 

NTD  data  are  available  online  at: https://www.transit.dot.gov/ntd/data-product/2016-fuel-and-
energy.  

Industrial  

Industrial end-use equipment activity is from the Manufacturing Energy Consumption Survey 
(MECS) (EIA 2017). The Manufacturing Energy Consumption Survey (MECS) is the Federal 
Government’s comprehensive source of information on energy use by U.S. manufacturers. The 
survey collects data on energy consumption and expenditures, fuel-switching capability, onsite 
generation of electricity, byproduct energy use, and other energy related topics. The Electricity 
Consumption Module uses 2002, 2006, 2010, and 2014 data from the MECS, and 1990 through 
2005 are proxied to 2002, 2007 through 2009 are proxied to 2006, 2011 through 2013 are 
proxied to 2010, and 2015 through 2020 are proxied to 2014. The Electricity Consumption 
Module utilizes regional-level data available from the MECS. 

MECS data are available online at: https://www.eia.gov/consumption/manufacturing/. 
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Step (7)  Review  Summary Information  

The  steps  above  provide  estimates  of  total  CO2  Eq.  emissions from  electricity  consumption. 
The  information  for each  sector is  collected  on  the  summary  worksheet,  displaying  results  in  
MMTCO2E.   Figure  6  shows the  summary  worksheet  that  sums the  emissions from  all  
sectors in  the  Electricity  Consumption  module.   In  addition,  the  results  are  displayed  in  
graphical  format  at  the  bottom  of  the  summary  worksheets.  Toggle  buttons  to  the  left of  
each  sector either expand  (“+”)  or collapse  (“-“)  rows  to  show  end-use  equipment  data.   

Figure 6. Example of the Emissions Summary Worksheet in the Electricity 
Consumption Module 
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Step (8) Export Data 

The final step is to export the summary data. Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
greenhouse gas inventory for the state. 

To access the “Export Data” button, return 
to the control sheet and scroll down to the 
bottom (8). Click on the “Export Data” 
button and a message box will open that 
reminds the user to make sure all steps of 
the module have been completed. If you 
make any changes to the Electricity 
Consumption module later, you will then 
need to re-export the results. 

Note: the resulting export file should not be 
modified. The export file contains a summary 
worksheet where users can view the results, as well as a 
separate data worksheet with an unformatted version of 
the results; this data worksheet contains the information 
that is exported to the Synthesis Tool, and it is especially 
important that users do not modify it. Adding/removing 
rows, moving data, or making other modifications 
jeopardize the ability of the Synthesis Module to 
accurately analyze the data. 

Clicking “OK” prompts you to save the file. 
The file is already named, so you only need to choose a convenient place to save the file. 
After the file is saved, a message box will appear indicating that the data was successfully 
exported. 
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While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 

Following data export, the module may be reset and run for an additional state. 
Alternatively, you may run the remaining modules of the State Inventory Tool to obtain a 
comprehensive profile of emissions for your state. 
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